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MillPlus, Software and Features

This manual describes functions and features provided the MillPlus as 
of the following NC software numbers:

*DP= 2-processor system

The most important limitation of the export version of the MillPlus is 
that simultaneous linear motions are only possible in up to four axes.

The machine manufacturer adapts the features offered by the MillPlus 
to the capabilities of the specific machine via configuration settings. 
Some of the functions described in this manual may therefore not be 
among the features provided by the MillPlus on your machine tool.

MillPlus functions that may not be available on your machine include:

Tool measurement with the laser measuring system
Software option 1 (see below)

Please contact your machine tool builder to become familiar with the 
features of your machine.

In addition, the MillPlus also has further software functions that can be 
enabled by you or your machine tool builder.

Intended place of operation

The MillPlus complies with the limits for a Class A device in 
accordance with the specifications in EN 55022, and is intended for 
use primarily in industrially-zoned areas.

Processor type NC software number

MillPlus IT V600 538 952-xx

MillPlus IT V600 Export 538 953-xx

MillPlus IT V600 DP* 538 954-xx

MillPlus IT V600 Export DP* 538 955-xx

MillPlus IT V600 Programming Station 538 956-xx
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New Functions

In addition to the scope of functions offered by previous versions of 
the control, the MillPlus V600 offers several new functions.

Here is a brief overview of these functions:

New and optimized motion control for shorter machining times
Programming aids include dialog entry, Function Explorer, context-
sensitive help for programming and operation
Universal mouse operation (for single- and dual-processor systems)
Clipboard function for data exchange within the control as well as 
with Windows applications (for dual-processor systems)
Programming enhancements, such as limit plane and zoning 
functions, contour cycles with contour linking, syntax highlighting, 
higher-language elements, SQL table access
Support for mid-program startup via the new program-structure 
function
Setting of breakpoints without changing the program; helps for 
testing the program as well as for practice runs
New tool and table editor. Dialog entry is also available for tools. The 
desired tools can also be selected via the tool-directory window.
All tables are shown in a grid display. You can optimize each table 
for its task, by changing the sequence or width of columns, by 
showing or hiding them, or by sorting the contents.
Improved simulation graphics with higher display resolution, block-
number assignment in the line graphics, simple jumping between a 
block and the corresponding line in the graphics.
Along with the 15.1” color TFT, a 19” version is also available. The 
19” TFT has 10 instead of only 8 function keys.

MillPlus IT Website

For more information, go to www.millplus.com or www.millplus.de
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Workshop oriented

The MillPlus IT is designed for use with milling, drilling, boring and 
machining centers, as well as for use with mold machines. The 
MillPlus IT can also be traversed manually for simple machining 
operations.

Direct access to machining cycles shortens setup times and avoids 
unneccessary programming work.

Optimized motion control shortens the machining time while at the 
same time providing a well-machined workpiece surface. The various 
machine characteristics (swivel head, tilting table, additional axis, etc.) 
are specified in the kinematics model, which lets you concentrate on 
the machining process.

Different types of aid are available to the programmer: dialog entry, 
Function Explorer, context-sensitive online help, graphic simulation, 
etc.

The user-friendly operating concept, which is similar to Windows, can 
be adapted to the user’s experience level.

MillPlus IT with Windows

The 2-processor version of the MillPlus IT uses the Windows 
operating system, providing a standard interface to further Windows 
applications. Data can easily be exchanged between the MillPlus and 
Windows applications via the Clipboard. Also, the control can easily be 
connected to your company network.

Other Windows oriented features available in both the single and 
double-processor versions:

Complete PC keyboard with integrated touchpad

USB ports, for easy attachment of standard PC peripherals, such as 
a mouse, CD-ROM drive, etc. to the control
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The MillPlus V600 has many new functions compared to previous 
versions of the MillPlus. Operation of the control has been developed 
further, but you will nevertheless recognize the familiar operating 
concept of the MillPlus. The NC programming of the V600 is also 
based on its predecessors.

However, there are also significant differences in some cases. For 
example, machining programs written on older MillPlus controls must 
be checked. If an NC block is not accepted by the V600, a warning will 
be issued when checking the program. Also refer to the Programming 
Manual.

Instructions

These instructions are intended to support you while using the control.

Please read the information collected for you in this manual before you 
begin working with your machine. The User’s Manual contains 
important information about operating the machine as well as 
operational safety, so that you may operate your machine in a safe and 
efficient manner.

Along with this User’s Manual, there is also a Programming Manual, 
in which the G functions are described in detail.

The User’s Manual and Programming Manual are also available online 
on the control.

Programming station

The MillPlus programming station, which runs on a PC with a 
Windows operating system, simulates the MillPlus control. Here you 
can create, test and optimize NC programs without needing a 
machine.
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We reserve the right to make changes to the features and accessories 
as part of further development. Therefore, no claims may be derived 
from the data, descriptions or images. Errors and omissions excepted.

The information in this manual is absolutely essential for safe 
operation of the machine. Ensure that it is readily available at the 
machine.

Regarding topics dealing with safety, please refer to the notes 
regarding proper use.

The configuration of the control is modified appropriately to 
interface it with the machine. Some of these configuration settings 
can be accessed by the operator. Caution! Before changing any 
configuration settings, be sure that you understand the meanings 
and functions thereof. Otherwise please contact your machine 
supplier’s service agency. Also refer to the Machine Manual for 
other information about your machine.

We recommend backing up your program and sensitive data at 
regular intervals, in order to avoid such information being 
irretrievably lost should a system defect occur.

© Heidenhain Numeric B.V. Eindhoven, 

Netherlands 2008

The publisher shall not assume liability for any specifications based on 
information contained in this manual. Solely the data contained in the 
order and the corresponding technical specifications shall apply for the 
specifications of this numeric control.

All rights reserved. Reproduction of this material, in whole or in part, 
is not allowed without written permission from the copyright holder.

Legal information

This product uses open source software. Further information is 
available on the control under:

Control operating mode

Menu: Installation >> Diagnosis >> Software

Legal information soft key
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Operating Panel

The MillPlus features a color flat-panel display and an operating panel:

Soft keys are assigned to the color flat-panel display

The operating panel consists of a standard ASCII keyboard (NC part) 
and a machine operating panel

Screen and NC keys

The following keys are located on the display unit, the keyboard and 
the machine operating panel:

The functions of the individual keys are described on the inside front 
cover.

Machine operating panel

The machine keys are located on the machine operating panel:

The functions of the individual keys are described on the inside front 
cover.

1 Select window
2 User soft keys
3 Soft-key row (NC functions)
4 Soft-key row (machine functions)
5 Info key
6 ASCII keyboard
7 Menu key
8 ALT key
9 Windows key
10 Applications key
11 Touchpad with selection and context buttons

12 NC switches: Emergency stop /NC on
13 Override knobs: Rapid traverse / Feed rate
14 Spindle control
15 Spindle-speed control
16 Main operating modes
17 Axis-direction keys
18 Keys for machine functions (PLC)
19 Start / stop keys
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The MillPlus has four main operating modes: Manual, Automatic, 
Programming and Control (Setup). A uniform manner of operating the 
MillPlus is made possible by the basic components of the user 
interface. This operation consists of navigation through windows 
using the touchpad, keys and soft keys.

Basic components

Main operating modes

The four main operating modes are shown as tabs at the top of the 
screen. The active main operating mode is light gray. Switch between 
the main operating modes with the Manual, Automatic, Programming, 
and Control keys (on the operating panel and on the ASCII keyboard), 
or use the touchpad to click the main operating mode tabs on the 
screen.

You can switch between the main operating modes of the MillPlus at 
any time, since they operate parallel to each other. Each mode 
maintains its current status when you switch to a different mode. An 
informational window can be opened in addition to the four main 
operating modes.

Symbols

The main operating modes are indicated with symbols on the tabs.

1 Main operating modes
2 Menu bar
3 Message line
4 System bar
5 Soft-key row (NC functions)
6 Soft-key row (machine functions)
7 Application window

Symbol Descriptions of the main operating modes

Manual: Manual operation and automated 
sequences for setting up machines, workpieces 
and tools.

Automatic: Breaking in workpiece programs, 
setting up the workpiece and automatic execution. 
The Manual operating mode is available during an 
interruption.

Programming: Create, edit, simulate and manage 
NC programs.

Control: Set up and manage the control, all control 
data, tool management, diagnostics and service 
functions.
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Symbols indicating the status of the respective main operating mode 
can appear in the main operating mode tab. These symbols are 
refreshed automatically. 

Menu bar

The menu bar gives an overview of the menus available in the 
respective main operating mode. The menus are drop-down menus, 
meaning that a small window appears with the appropriate menu 
items when the menu is selected.

This menu window shows the selectable functions and operating 
modes. Arrows in the menu window indicate that further window 
menus can be opened.

All soft keys are deactivated while a menu window is open. Only once 
a menu has been selected or the menu bar deactivated do the soft 
keys become active again.

Symbol Description

Program is running

Program run is paused

Program run is paused, and the program is open for 
editing

An error has occurred

Warning

Display of dwell time or time remaining

Program status, such as End of program
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There are different methods for selecting the functions and operating 
modes of the menus:

Touchpad

Arrow keys

Number keys

1 Touchpad

  Use the mouse pointer to select a menu from the 
menu bar. Click a menu item to open its menu 
window, and then move the mouse pointer to the 
desired function or operating mode. Click the function 
or operating mode to activate it.

2 Arrow keys

 Press the MENU key or

 the ALT key to open the menu

 Use the LEFT/RIGHT arrow keys to select a different 
menu from the menu bar

 Use the UP/DOWN arrow keys to select a function or 
operating mode from the menu window

 Activate the selected function or operating mode

3 Number keys

 Press the MENU key or

 the ALT key to open the menu

 Press the keys 0 - 9 in sequence to activate a function 
or operating mode from the menu 

Example: Press 2 and then 2 again to activate the Measure in 
jog function.



HEIDENHAIN MillPlus V600 25

1
.3

 O
p

e
ra

ti
n

g
 C

o
n

c
e

p
tMessage line

Error message

The control displays current messages for the operator in the 
message line.

The messages appear in the message line, with a yellow 
background

A symbol may also be displayed in the main operating mode tab at 
the same time.

 Press CLEAR to remove the error message, or

Error info

 Press INFO to open the online help (see “Online Help 
and Calculator” on page 37).

System bar

The following symbols are shown in the system bar:

Messages Description

Machine Messages referring to the machine (PLC)

Operation Messages about the sequence of operations

Programming Programming errors or notes regarding the syntax

Symbol Description

Info key

User soft keys

Recording

Keyboard: Number lock on

Keyboard: Caps lock on

Time
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Standard soft keys

Use the soft keys to directly activate a function permitted in the active 
operating mode. The soft keys can also be activated with the 
touchpad.

User soft keys

You can also define your own soft keys, in order to specify optimized 
sequences. The user soft keys are superimposed over the standard 
soft keys if the USER key (at the edge of the display unit) is pressed, 
or if the same main operating mode is selected twice in a row. Select 
the main operating mode again to display the standard soft keys again.

Soft-key row: Machine functions

The machine soft keys activate machine-specific functions. The 
functions depend on the machine, and are specified by the machine 
manufacturer via the PLC.

Application window

You can enter your data or influence the sequences of the selected 
program directly in the applications window, depending on the active 
operating mode. Some examples of application windows are:

Manual: Next to the graphic of the machine is an input window, in 
which you can enter commands and then run them.

Automatic: The folders and files are displayed for selection of the NC 
program. Once a program has been selected, it is shown over the 
entire width of the window.

Programming: The program opened in the editor is shown over the 
entire width of the window. If the graphic simulation function is 
activated, then a part of the window is used for this.

Control (Setup): You can see and edit the tool data in a tabular view.

Symbol Description

Soft key inactive

Soft key active

Soft key with an arrow in the corner indicates 
another soft-key row
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Typical functions are available in multiple locations on the MillPlus.

The basic operating functions are:

Input dialogs

File manager

Table editor

NC editor

Editing functions

Shortcuts

Popup windows

Context menu

Machine status display

Online help

User soft keys

Input dialogs

Support for data entry is available when creating a program in the 
program editor or with MDI, which helps you to structure the program 
block as needed. The level of support automatically adapts itself to the 
data entered in the block. The MillPlus offers a structured search view: 
the Function Explorer. The data-entry support is opened with the 
Dialog soft key.

Function Explorer

All functions and tools are collected by their functions into groups in 
the Function Explorer. This grouping makes it simple to find the 
function you are looking for. Press the ENTER key to open the 
selected function in the input dialog.

The main groups are: 

G functions

M functions

T tools
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The level of support adapts itself to the respective contents of the 
program block when the Dialog soft key is activated.

 Activates support for data entry. If a G function or an 
M function is entered (such as G81), then the input 
dialog window opens and the data can be entered via 
the keyboard. If only a G or an M is entered, or 
nothing at all, the Function Explorer opens 
automatically.

 Activates the Function Explorer. Select the desired 
function, and open it with the ENTER key.

 Saves the entered data in the program block. The 
input dialog window is closed.

 Data entry is cancelled in the dialog input window 
without saving the data in the program block.

File manager

To ensure that you can easily find your files, we recommend that you 
organize your hard disk into directories. You can divide a directory into 
further directories, which are called subdirectories. Use the file 
manager to select a file.

The file manager is available in the following operating modes:

Automatic, via the menu bar: NC-Program > Select

Programming, via the menu bar: NC-Program > Open or via the 
context menu Save as while a program is open

Control, via the menu bar: NC-Explorer > File

At the top of the list of drives you will find special drives with the 
opened programs in Automatic and Programming modes.

Screen layout

The file manager is divided into four window panes:

1 Explorer window with:
List of drives
Directories and subdirectories

2 Directory and file window with:
List of files in the selected directory

3 File preview window
The window shows a preview of the selected file

4 Filter window with:
File name or a part of it to be searched for
File type (*.pm, *.mm, etc.)



HEIDENHAIN MillPlus V600 29

1
.4

 B
a

s
ic

 O
p

e
ra

ti
n

g
 F

u
n

c
ti

o
n

sNames of files and directories

The name can consist of any letters and numbers. 
The characters * \ / “ ? < > > are not permitted.

Sequence of operations

If you want to open a program, such as for program run in Automatic 
mode, first use the file manager to find the program.

Sequence of operations with the ASCII keyboard

 Open the menu bar and select the NC-Program menu 
item. In this menu, choose the Select or Open 
functions.

Navigation in the file manager

 Press TAB to switch the focus between the various 
panes.

 Use the arrow keys to open a drive or directory in the 
Explorer window [1].

Press the right arrow key again to switch the focus 
to the file window [2].

Press the left arrow key to switch the focus back to 
the Explorer window [1].

 Press the ENTER key to open a file.

 Press ALT+arrow key in the filter window [4] to select 
a previous filter setting or file name.
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All tables with data regarding tools, datum shifts, etc, are available in 
the Control (Setup) main operating mode.

Available tables:

Tools

Tool magazine

Zero offsets

Parameters

Points

Editing a table

If a table is simply activated, then you can only view the information. 
The table itself has a gray background. If you want to edit a table 
(change the contents or add new data, for example), you must open 
the table by pressing the Edit soft key. You can make your entries in 
the table itself, or if the Dialog soft key is available, you can use the 
support for data entry.

Finding

 Enter the string you want to search for in the Find 
window, and press the Find next soft key or press 
ENTER. You can repeat the search by pressing these 
keys repeatedly.

Table settings

The table view can be configured, i.e. you can optimize it for your 
application. The following settings are available:

Column assignment and order:
Position the mouse pointer on a column header and press the right 
mouse button to open the context menu. Select Column order. The 
Column order window shows the possibilities for configuration.

Show columns: In the Columns to display window you can select 
which columns are to be shown.
Column order: Indicate in Move column before what the order of 
the columns should be. 
Press Default to return to the default setting.

Column width:
Position the mouse cursor to the left or right edge of a column 
header. Press the left mouse button and drag the column to its 
desired width.

Sort data:
The data in a column is sorted in either ascending or descending 
order. An arrow in the column header shows the sort order. Click in 
the column header with the left mouse button to change the sort 
order.
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You can use the NC editor to create and edit NC programs. The 
program editor is available in the following main operating modes:

Programming: Edit > NC-Editor

Control: NC-Explorer > File

The NC editor builds the program line by line. Each line consists of the 
NC block and a line number. The line numbers are automatically 
generated in ascending order. Use the keyboard to enter the data for 
the program block.

Syntax highlighting

The program blocks consist of various elements, such as G functions, 
comments, FMST, etc. These elements can be shown in different 
colors in the block.

Select the Settings > Edit menu item to activate syntax highlighting 
and choose the colors.

Syntax checking

The correct syntax of a program can be checked while the blocks are 
being programmed.

Select the Settings > Edit menu item to activate program checking.

Line number and status symbol

The gray column to the left of the program shows the line number, the 
line cursor, and a status symbol in front of the respective block.

Status symbol: 

Symbol Description

Warning, syntax error in the block
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1 Creating or editing a program

 In order to create an entirely new program, select the 
NC-Program > New menu item.

 In order to open an existing program, select the 
NC-Program > Open menu item.

 If you want to save the new or edited program, press 
the Save soft key. A window appears in which you can 
enter the program name and type.

2 Support during programming

 Open the input dialog window during program entry in 
order to simplify the entry of data.

 The grouping of functions makes it simple to find the 
function you are looking for.

 Press the INFO key or icon to call the soft keys for the 
calculator and the online programming aids.
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You can use the editing functions to change the contents of one or 
more line in the MDI list or in programs: 

Soft key Description

Mark this part of the block for cutting, copying or 
pasting

Undo an action (CTRL+Z)

Redo the undone action (CTRL+Y)

Find any text within a program, and replace it with a 
new text if desired. A line number can also be 
searched for instead of a text. (CTRL+F)

Cut the marked block parts (CTRL+X)

Copy the marked block parts (CTRL+C)

Inserted the marked block parts after the cursor 
position (CTRL+V)
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To speed operation, some functions can be activated via shortcuts. 
These functions are also available via soft key or over the context 
menu.

Some frequently-used shortcuts: 

Popup windows

Sometimes a popup window for a temporary function (such as 
searching, saving, etc.) appears within the current application. This 
popup windows appears on top of the current application window.

A soft-key row belonging to the popup window is shown. Press ESC to 
close the popup window.

In some cases you can switch the focus between the popup window 
and the application below it, such as the Find window in the NC editor. 
In these cases the MillPlus ensures that the correct soft-key row is 
always displayed.

The focus cannot be changed away from some popup windows. Such 
popup windows must be closed first.

Context menu

Call the context menu via the ASCII keyboard (applications key) or by 
clicking the right mouse button. The context menu shows you a list of 
functions available in the active operating mode. The opened context 
menu closes automatically if you press ESC or if you select a function.

Shortcut Description

CTRL+S Save a program

CTRL+F Find (replace)

CTRL+C Copy

CTRL+V Paste

CTL+Z Undo
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The status display informs you of the current state of the machine tool. 
The status display appears automatically in the following operating 
modes:

Manual

Automatic

General status display

1 X, Y, Z, A, B, C: Axis positions
Actual value
Distance-to-go

2 T: Tool number
Programmed tool
Current tool
Tool index

3 G53 - G59: Datum shift
4 G17 - G18: Machining plane

5 F: Feed rate
Programmed feed rate
Active feed rate
Feed rate for plunging
Override value for feed rate/rapid traverse

6 Program run time
PM: Program
T: Tool

7 G4: Dwell time

Symbol Description

Axis clamping

Axis transformation

Symbol Description

G0: Rapid traverse

G1: Feed rate
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s 8 S: Spindle speed

Programmed

Spindle override

9 Program status

Additional status displays

Additional status displays, with detailed information about the 
program run, can be shown during program run and MDI.

To switch the status display:

 Press the Status display soft key to show a new 
soft-key row, with a selection of the various possible 
status displays.

Symbol Description

M5: Spindle stop

M3: Spindle left

M4: Spindle right

Symbol Description

G73: Scale
G73: Mirror
G93: Rotate coordinate system
G07: Tilt the machining plane

Soft key Description

The machine picture is the default display

Information about the execution status:
- Active G functions
- Active M functions
- Angle G7
- Rotation G93
- Mirroring G72
- Scaling G73

Information about offsets:
- Axis positions G52, G54, G92+G93
- Tool

Information about E parameters:
- Parameters E+ES
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INFO functions

At all times and in all main operating modes, you can call additional 
online help or a pocket calculator. Press the INFO key or icon, and then 
the appropriate soft key, to select one of these functions.

  Call the online help and calculator

The online programming and operating support appear in a popup 
window. You can use the mouse pointer to change the size and 
position of this window.

Programming support

Press INFO and then the Programming support soft key to find all 
programming functions, including the programming language, of the 
MillPlus online. This online support can be of assistance while you are 
entering a program.

The online help is context-sensitive: if a program is being entered, then 
the online help jumps directly to the detailed information about a 
function. If there is no programming context, then the online 
programming support opens with the overview of function groups.

Operating support

Press INFO and then the Operating support soft key to find all 
operating functions of the MillPlus online.

Soft key Description

Call online programming support

Call online operating support

Call explanations and fixes in case of error messages

Call the calculator
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In case of an error, the MillPlus automatically shows a brief description 
of the error in the message line above the soft keys. Error messages 
occur if:

Incorrect data was entered during programming

Logical errors arise in the program during program testing or 
program run

System errors during operation

If you require additional information about an error message, press 
INFO and then the Error support soft key.

A popup window appears:

List of error messages

A description of the error cause and error fix for each error.

Calculator 

The MillPlus features an integrated pocket calculator with the basic 
mathematical functions. The calculator can be called with INFO from 
any location.

You can use the calculator to calculate intermediate results during 
programming. These values can be sent directly to the cursor position 
in the program editor with the Insert result soft key.

Click the View button with the mouse to cycle through the three levels 
of calculator functions.
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User soft keys, which you define yourself, are available in addition to 
the standard soft keys. These user soft keys enable quick and 
customized operation anywhere on the control.

Operation

User soft keys that are superimposed over the standard soft keys are 
available in all operating modes. Use this feature to create your own 
operating level, where you can have numerous operating steps or 
sequences be performed via a soft key. 

Active the user soft keys by:

Pressing the USER SOFT KEYS key at bottom left on the display 
unit, or by

Pressing an operating mode key twice, or by 

Clicking an active operating mode tab with the mouse.

 The user soft keys symbol appears in the system bar.
 

The standard soft keys appear again after a user soft key has been 
activated, or after a main operating mode has been selected again.

Recording a user soft key

After placing the mouse pointer over a new user soft key that you 
want to define, open the context menu. Activate either the “Record 
UK” or “Cancel record UK” function. 

 The recording symbol appears in the system bar. 

All keys pressed (on the ASCII keyboard as well as the operating panel, 
except for the Start and Stop keys) and all mouse clicks are recorded 
in sequence.

Stop recording by clicking the recording symbol.

You can then assign a text or an image to the user soft key.
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You can choose to assign texts or images to user soft keys. The text 
or the image file name is assigned in a table in the Control (Setup) 
operating mode. The image file must be saved in the “Userkeys” 
directory on the “V” drive. 

 Select the Control (Setup) main operating mode. 

 Select the following function from the menu: 
Installation >> Configuration >> User soft keys

 Open the table for editing.

Deleting a user soft key

You can delete a user soft key from the table in the Control (Setup) 
main operating mode. 

 Select the Control (Setup) main operating mode.

 Select the following function from the menu: 
Installation >> Configuration >> User soft keys

 Open the table for editing. Remove the text and image 
name of the recording, and

 Delete the selected recording.
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System

Axis configuration

A machine has three linear principal axes (X, Y Z), which are mutually 
perpendicular. The orientation of these axes is determined by the 
Z axis, which always runs parallel to the machine tool’s spindle. The X 
axis is that with the greatest traverse path perpendicular to the Z axis. 
A rotary axis can be assigned to each principal axis. (top figure)

Coordinate system

The CNC can connect points by linear and circular paths of traverse 
(interpolations). Workpiece machining is programmed by entering the 
coordinates for a succession of points and connecting the points by 
linear or circular paths of traverse.

The positions of the CNC machine tool’s axes are defined by the 
following standards: ISO 841, DIN 66217 and EIA RS-267-A. (center 
figure)

Defining coordinates

The coordinates of points in space (3-D) define traverse paths along 
the axes. The axis coordinates are in one of three planes (XY plane, ZX 
plane, YZ plane).

The coordinates can be entered using absolute, incremental, Cartesian 
or polar coordinates.

G7 coordinates

The position display on the screen can toggle between the position in 
the G7 plane (Xp, Zp) or the machine coordinates (X, Y). Both refer to 
the active datum G52 + G54 + G92/G93. (bottom figure)
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In order to determine the machine datum, a reference run must first 
be performed after switch-on. The machine datum is specified, since 
the offset data between the machine datum (M0) and the machine-
based reference point (R) is saved via machine configuration data.

R = machine reference point

M0 = machine datum

W = program datum

The operator specifies a program datum (W) for the workpiece, 
relative to which the workpiece dimensions are measured. This 
program datum must also refer to the machine datum, which can be 
specified with the G52 and/or G54...G59 functions.

Machine-based reference point (R)

Every traversable axis of a machine tool has a stationary point 
designated as the reference point. The reference points of all axes 
together form the machine-based reference point (R) (bottom figure).

During the reference run (see “Crossing over the reference point” on 
page 47), the tool traverses to the reference point of each respective 
axis. Once this point is reached, the CNC automatically zeroes the 
axis. The positions of the software limit switches are specified.



Manual Operating Mode



44 2 Manual Operating Mode

2
.1

 I
n

tr
o

d
u

c
ti

o
n 2.1 Introduction

The Manual operating mode provides functions for simple machining 
operations, for setting up the machine, and for setting up and pre-
machining workpieces. In this operating mode, you operate and move 
the machine axes and the spindle manually.

G-code commands for positioning the axes and machining simple 
workpieces as well as for machine and tool functions are entered and 
executed blockwise. You can intervene or interrupt program run, and 
then resume or cancel program run.

You can save the most important machine functions and machining 
operations in an MDI list and reuse the NC blocks from this list at a 
later time.

Menu bar

In the Manual operating mode, select subordinate operating modes or 
functions from the pull-down menus in the menu bar.

Menu Description

Workpiece Workpiece setup: Setting the zero 
points and workpiece measurement

Tool Tool setup: Tool measurement, entry 
of tool technology data and setting the 
plane

MDI Manual data input and execution of 
instruction sets

Machine tool Machine-related functions: 
Reference-point traverse, axis 
diagnosis and shutdown of the 
MillPlus

Settings Settings parameters for the functions 
in the Manual operating mode



HEIDENHAIN MillPlus V600 45

2
.1

 I
n

tr
o

d
u

c
ti

o
nMenu items

The pull-down menus contain the following menu items providing the 
functions or operating modes described below: 

The menu items identified by an asterisk (*) are not 
supported by this software version.

Workpiece menu Description

Touch side Setting the workpiece zero point with 
a tool 

Determine center Setting the workpiece zero point in 
the center of a circle or rectangle by 
using the tool

Preset axes Setting the current position as the 
workpiece zero point

Measure side * Setting the workpiece zero point with 
a touch probe

Tool menu Description

FST entry Manual data input and execution of 
technological functions

Measure in jog Tool measurement by touching the 
workpiece with the tool

Set plane Activation of a working plane

MDI menu Description

Free entry Manual data input and execution of 
instruction sets

Machine tool menu Description

Reference point Determining the axis position through 
reference point traverse

NC shutdown Shutting down the control in order to 
switch off the machine

Settings menu Description

Jogging Axis settings for jog operation
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Switch-on

 Switch on the power supply of the machine and the MillPlus.

On a MillPlus with dual-processor system (Windows XP), the startup 
screen (Log On to Windows) appears after switch-on.

 Enter the appropriate data in User name, Password and Log on to. 
For the data to be entered, refer to your machine manual, the 
system administrator or your machine supplier.

Booting the MillPlus

 Release the EMERGENCY STOP switch.

 Press and hold the MACHINE ON button.

 Press the CLEAR key.

The MillPlus starts up in the Manual operating mode and is now ready 
for operation. You can execute the following functions:

Positioning the axes with the AXIS-DIRECTION KEYS

Crossing over the reference points

Switch-on and traversing the reference points can vary 
depending on the machine tool. Refer to your machine 
manual.
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After the MillPlus has started up, all axes must cross over the 
reference point. You can move the axes manually, but you cannot 
execute any commands in MDI or any programs in Automatic 
operating mode until the reference points have been crossed over.

Standard working plane

The reference run can be executed separately for each individual axis 
or for more than one axis simultaneously.

 Select all axes.

 Select one axis.

 After you have pressed the START key, the selected 
axes simultaneously move to the reference point at 
feed rate.

After the reference point has been crossed over, the MillPlus 
executes a machine-dependent rapid traverse movement to a fixed 
position.

The MillPlus is now ready for operation in the Manual operating mode.

Traversing the reference point in a tilted working plane

Axes that are equipped with absolute encoders do not 
have to cross over the reference points. If all axes are 
equipped with absolute encoders, the MillPlus is ready for 
operation immediately after the machine control voltage is 
switched on.

The reference points need only be crossed over if you 
want to traverse the machine axes. If you only want to edit 
or test programs, select the Programming operating mode 
after switching the machine control voltage on. You can 
then cross over the reference points later.

The tilting of the plane is automatically cancelled when the 
reference point is traversed in an axis.
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To prevent data from being lost at switch-off, the operating system of 
the MillPlus needs to be shut down properly:

 Select the Manual operating mode.
 Select Machine tool > NC shutdown.

 Shut down the MillPlus.

Moving the machine axes: Jogging

The axes are moved with the axis-direction keys:

in continuous jog mode

in incremental jog mode (0.001-1.000), or with a free increment

at a predefined feed rate, or at a programmed feed rate

See “Jogging” on page 63.

Continuous jog

Use the axis-direction keys to move a single axis or more than one axis 
simultaneously.

 Press the  Step/Continue soft key to select the 
continuous jog mode.

 Press the axis-direction key and hold it as long as you 
wish the axis to move.

 The axis feed rate is adjusted with FEED RATE 
OVERRIDE (0-100%).

 If you press an axis-direction key and the RAPID 
TRAVERSE key simultaneously, the axis moves at 
rapid traverse speed.

Inappropriate switch-off of the MillPlus can lead to data 
loss.

Manual traverse with the axis-direction keys can vary 
depending on the machine. The machine tool manual 
provides further information.

���

�� ���

�



HEIDENHAIN MillPlus V600 49

2
.2

 G
e

n
e

ra
l 

F
u

n
c
ti

o
n

sIncremental jog

In incremental jog mode, you move a machine axis by a preset 
distance.

 Press the  Step/Continue soft key to call the Step soft 
keys.

 Set the jog increment with the Step 0.0010 soft key, 
for example.

 Press the axis-direction key. The axis moves in steps 
of 0.0010.

Moving the axes in a tilted plane

Using the axis-direction keys, you can also move the axes in a tilted 
plane. When the tilted plane is active, you must switch on jog 
movement in the tilted plane by pressing the soft key showing the 
tilted plane symbol. When movement in the tilted plane is active, "P" 
is displayed next to the axis designations, and the yellow symbol for 
tilted plane appears in the machine status display.

 Press the Step/Continue soft key in the Manual 
operating mode.

 Select tilted plane.

Traversing with the HR 410 electronic handwheel

The portable HR 410 handwheel is equipped with two permissive 
buttons. The permissive buttons are located below the star grip.

You can only move the machine axes when a permissive button is 
depressed (machine-dependent function).

The HR 410 handwheel features the following operating elements:

1 Emergency Stop button
2 Handwheel
3 Permissive buttons
4 Keys for axis selection
5 Keys for actual-position capture
6 Keys for defining the feed rate (slow, medium, fast; the feed rates 

are set by the machine tool builder)
7 Direction in which the MillPlus moves the selected axis
8 Machine functions (set by the machine tool builder)

The red indicator lights show the axis and feed rate you have selected.
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function M

Application

In the Manual operating mode the values for tool T, machine function 
M, spindle speed S and feed rate F are entered with FST entry or MDI 
Free Data Input.

Entering values with FST or MDI > Free entry

Enter the following values:

1 Tool call T with machine function M

2 Spindle speed S, alternatively with a machine function M

3 Feed rate F

Executing the values entered

 Start spindle rotation at the entered speed S, or start 
tool change with the entered tool number T.

 Execute feed rate F, and move the axis/axes at the 
entered feed rate if axis/axes are programmed.

Adjusting rapid traverse, feed rate and spindle speed

The override knobs are located on the machine operating panel.

With the override knobs, you can vary the spindle speed S and the 
feed rate F:

 Rapid traverse from 0% to 100%

 Feed rate F from 0% to 150%.

With the spindle keys, you can vary the value set for spindle speed S:

 Spindle speed S to 100%

 Increase spindle speed S (%)

 Reduce spindle speed S (%)

The MillPlus provides standard and machine-related 
machine functions M. The machine tool builder 
determines which machine functions M are available on 
your control.

�
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Manual axes are rotary or linear axes that are equipped with a position 
measuring system, but they do not have a servo drive. In Manual 
operating mode, manual axes can be moved to the desired position at 
any time.

Programming manual axes

If manual axes are positioned via the program, the MillPlus will inform 
the machine operator about it. Program run stops and the following 
messages appear:

The status bar displays the "Positioning manual axis" message.

The distance-to-go display for the affected axes is highlighted in 
yellow. 

The machine operator moves the manual axis/axes until the distance-
to-go value is 0. Once the distance-to-go value is within a certain 
tolerance, the distance-to-go display turns green and program run can 
be resumed. If the manual axis is not within the tolerance when 
program run is restarted, the MillPlus issues the error message 
"Manual axis not in position".

If the movement of a manual axis is smaller than the 
tolerance window, the MillPlus nevertheless stops 
program run and the distance-to-go display is 
highlighted in green.

If the difference between the nominal position and the 
actual position is less than the programming format 
(0.001 or 0.0001 degrees), the deviation is not treated as 
a movement and does not lead to a program stop.

It is not allowed to interpolate NC axes and manual axes. 
The MillPlus then displays the error message "Axis and 
manual axis not permitted."
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Manual data input and execution of instruction sets. This operating 
mode provides the following functions:

1 Entry and execution of individual blocks
2 The blocks entered are saved in the MDI list and can be reused 

later.

Programming and executing simple machining operations

The MDI operating mode enables you to set up the machine and to 
execute simple machining operations. The individual instructions (ISO 
or cycles) are entered blockwise in the MDI input window. Then press 
the START key to have the MillPlus execute the respective block. The 
block is saved in an MDI list (see “MDI Menu” on page 61).

The MDI list is saved in a file on the “Work“ drive. The $MDI.pm file 
can be opened in the program editor.

Structure of the MDI list

The MDI list is a list of instruction sets. The blocks entered need not 
be related to each other. They may be listed in any sequence and do 
not make up an NC program.

Support for data entry

You can use the support for data entry, while you are entering data. 
The level of support adapts itself to the respective contents of the 
program block. Use the function explorer to select a function and enter 
the appropriate data in the input dialog. See “Function Explorer” on 
page 27 and “Input dialogs” on page 27.

Limitations of MDI

Contour programming, programming graphics, 
subprograms, program section repeats, and path 
compensation are not available.
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Press the START key to execute the block you have entered, or a block 
you have selected from the MDI list. After the block has been 
executed, the cursor remains on the block.

Status information

During the execution of a block, the MillPlus provides detailed 
information on the current machining status. For example, the modal 
G functions and the current contents of E parameters are shown. See 
“Additional status displays” on page 36.

Edit functions

The Edit functions allow you to change the contents of one or more 
lines in the MDI list. The Cut,  Copy, and Paste functions are available. 
You can also find a text in the MDI list. See “Editing functions” on 
page 33.
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When the MillPlus is ready for operation and the reference points have 
been crossed, the zero points can be set.

You fix a zero point by setting the MillPlus display to the coordinates 
of a known position on the workpiece.

The measured zero point shift is saved as the active zero point G54-
G59 or G54 I...

Preparation

Clamp and align the workpiece.

Insert a tool with known radius and length.

Select the desired zero point G54-G59 or G54 I... 

Zero point setting with the axis-direction keys

In the Manual operating mode, the Workpiece menu offers various 
functions for setting the zero point. See “Workpiece Menu” on 
page 56.

Protective measure

If the workpiece surface must not be scratched, you can 
lay a metal shim of known thickness d on it. Then enter a 
nominal value that is larger than the desired value by the 
value d.
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Each tool is identified by a number. The associated tool data are saved 
in the tool table. When a tool is inserted from the tool magazine into 
the spindle with the Txx and Mxx commands, the tool data are 
assigned to the active tool.

The MillPlus can measure tool data

with Tool > Measure in jog in the Manual operating mode (see 
“Tool Menu” on page 59).

with MDI > Free entry in the Manual operating mode (see “MDI 
Menu” on page 61).

during program run in the Automatic operating mode. See the tool 
measurement cycles in the “G600-G699 Measuring Cycles” 
chapter of the Programming manual.
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Workpiece setup: Zero point setting and workpiece measurement

The Workpiece menu contains the following menu items:

Touch side

Determine center

Preset axes

Touch side

Setting the workpiece zero point with a tool.

You set the workpiece zero point by touching a workpiece edge with 
the tool. Enter the nominal value and confirm the axis traverse 
direction. The zero point is saved as the active ZPS number.

Activating the zero point

The zero point is saved as a ZPS number. In order to activate the zero 
point, the corresponding ZPS number must be activated in the zero 
point table.

 Open the zero point table.

 Use the arrow keys to select the zero point number 
(e.g. G54 I1) and activate it. The zero point (G54 I1) is 
displayed in the machine display.

Touching a workpiece edge

 In the input window, enter the nominal value of the 
workpiece edge to be touched.

 Using the axis-direction keys, move the tool to the 
workpiece edge and touch (scratch) it with the tool.

 Confirm the appropriate axis traverse direction by soft 
key.

This saves the zero point of the respective axis as the active ZPS 
number. The other axis reference values are determined in the same 
manner.
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Setting the center of a workpiece with a tool.

You determine the center of the workpiece as the workpiece zero 
point by touching two opposing workpiece edges with the tool. Enter 
the nominal values and confirm the axis traverse direction. The center 
is determined and saved as the active ZPS number.

Activating the zero point number

The zero point is saved as a ZPS number. In order to activate the zero 
point, the corresponding ZPS number must be activated in the zero 
point table (see “Touch side” on page 56).

Touching a workpiece edge

 Using the axis-direction keys, move the tool to the first 
workpiece edge and touch (scratch) it with the tool.

 In the input window, enter the nominal value of the 
probed workpiece edge.

 Confirm the appropriate axis traverse direction by soft 
key.

Move the tool axis to the opposite workpiece edge 
and touch (scratch) it with the tool. 

 In the input window, enter the nominal value of the 
probed workpiece edge.

 Confirm the appropriate axis traverse direction by soft 
key.

 The measured center is saved as a ZPS number. The 
other workpiece centers are determined in the same 
manner.
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Setting the current position with a tool. 

To determine the actual position value, move the tool manually to any 
desired position. Enter the desired nominal position value. The value 
is saved as the active zero point.

Activating the zero point

The zero point is saved as active zero point G54-G59 or G54 I... . In 
order to activate it, the corresponding ZPS number must be activated in 
the zero point table (see “Touch side” on page 56).

Moving to a position

 Enter the nominal position value in the input window.

 Using the axis-direction keys, move the tool to any 
desired position.

 The zero point is set in the axes in which the nominal 
value is entered.
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Tool setup: Tool measurement, entry of tool technology data and 
setting the plane.

The Tool menu contains the following menu items:

FST entry

Measure in jog

Set plane

FST entry

Entry and execution of technological machine functions.

You can enter machine functions, such as tool Txx, spindle speed 
Sxxxx, machine functions Mxx and feed rate Fxxxx. Press START to 
execute the functions.

Entering and executing technological functions

 Select Tool in the menu bar.

 Select FST entry and press ENTER to activate it.

 Enter the data for T, M, S and F in the input window.

 After you have pressed the START key, the machine 
will execute the functions. The current values for F, S 
and T are displayed in the machine display.

Finding tool Txx

If you want to select the tool from the tool table, proceed as follows:

 Open the tool table.

 Select the tool number Txx with the arrow keys.

 The tool number from the tool table is transferred to 
the FST entry window.

Please keep in mind that when you start the functions,

the spindle may start, and 

the axes will move to the tool change position if a tool is 
entered.



60 2 Manual Operating Mode

2
.4

 T
o

o
l 

M
e

n
u Measure in jog

Tool measurement by touching the workpiece with the tool. 

To measure a tool, touch the workpiece at a known dimension with 
the tool tip in the working plane or tool axis. When you press a soft key 
for the axis traverse direction, the MillPlus calculates the tool 
compensation values R or L from the nominal value entered.

Measuring the tool radius

 Select Tool in the menu bar.

 Select Measure in jog and press ENTER to activate it.

 In the input window, enter the nominal value of the 
workpiece edge to be touched.

 Using the axis-direction keys, move the tool to the 
workpiece edge and touch (scratch) it with the tool in 
the working plane.

 Press the soft key for the corresponding axis traverse 
direction (X or Y) in the working plane.

The MillPlus calculates the tool radius R for this axis and stores it in 
the tool memory. The compensation value for the measured tool is 
displayed in the tool data window.

To measure the tool length L, use the same procedure (touching the 
workpiece) in the tool axis direction.

Set plane

Activate the working plane.

The working plane is switched and activated with the Plane nn soft 
keys.

Setting the plane (e.g. XY)

 Select the Plane XY.

 Activating the plane.

The machine display shows the current plane.

You cannot measure the tool until you have inserted the 
tool into the spindle and activated the tool. The tool 
change function can vary depending on the individual 
machine tool. The machine tool manual provides further 
information.
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Manual data input and execution of instruction sets

The MDI menu contains the following menu item:

Free entry

Free entry

Manual data input and execution of individual functions and machining 
operations.

In the Free entry window, you enter the individual instructions block 
by block. Then press the START key to have the MillPlus execute the 
respective block. The block is saved in an MDI list.. See “MDI: Free 
entry” on page 52.

Entry and execution

 Select MDI in the menu bar.

 Select Free entry and press ENTER to activate it.

 Use the keyboard to enter the data in a line of the MDI 
list.

 Press the START key to execute the block.

Support for data entry

You can use the support for data entry, while you are entering data. 
See also “Input dialogs” on page 27.

 Activate support for data entry.

The level of support adapts itself to the respective contents of the 
program block.

1 Entered data is known (e.g. G81): The support window shows the 
input window for the function (G81: Drilling/Centering)

2 Entered data is not known (e.g. Gxx or empty block): The function 
explorer displays an overview of all G code functions.

 After the entry has been concluded, the MillPlus 
returns to the Free entry window. The block is saved 
and ready for execution.
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Machine-related functions: Reference point traverse, axis diagnosis 
and shutdown of the MillPlus.

The Machine tool menu contains the following menu items:

Reference point

NC shutdown

Reference point

Determining the axis position through reference point traverse.

After the MillPlus has started up, all axes must cross over the 
reference point (see “Crossing over the reference point” on page 47). 
If you want to repeat the reference run of the axes, proceed as 
follows:

 Select Machine tool in the menu bar.

 Select Reference point and press ENTER to activate 
it.

 Select One axis or 

 All axes to traverse the reference point in one axis or 
in all axes.

After the axis/axes has/have crossed over the reference point, the 
current position will be displayed in the actual-value display.

NC shutdown

Shutting down the MillPlus properly.

 Select Machine tool in the menu bar.

 Select NC shutdown and press ENTER to activate it.

 Press the OFF soft key to switch the MillPlus off.

Axes that are equipped with absolute encoders do not 
have to cross over the reference points. If all axes are 
equipped with absolute encoders, the MillPlus is ready for 
operation immediately after the machine control voltage is 
switched on.
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Settings parameters for the functions provided by the menus and 
menu items in the Manual operating mode.

The Settings menu contains the following menu items:

Jogging

Jogging

Axis settings for operation in jog mode.

The jog feed and the Free step value for the axes are defined in this 
window.

 Select Settings in the menu bar.

 Select Jogging and press ENTER to activate it. The 
MillPlus opens the Settings >> Jogging window.

 Enter the nominal value of the Free step value in the 
input window.

 Press the Step/Continue soft key to call the soft key 
on which the step size is displayed.

Possible settings in the Settings >> Jogging window:

1 Free step value
Set the free step value. The step size entered can be selected 
by pressing the Step/Continue soft key and then the 
corresponding soft key (F5).

2 Jog feed
Select a predefined or programmed feed rate for jogging.

3 Select axis
Assign the axis to the freely assignable axis-direction keys +/–.
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In the Automatic operating mode the MillPlus runs a part program in 
single-block or full-sequence mode to its end. For this the program 
needs to be selected from the work folder and be prepared by using 
the file manager.

Programs that were created with the MillPlus or with an external CAD 
system ensure high-accuracy machining at high speed.

The mid-program startup function (block search) enables you to run a 
part program from any desired block. The MillPlus scans the program 
blocks up to that point.

Menu bar

In the Automatic operating mode you can select a subordinate 
operating mode or a function by using the menu bar or the menu 
items.

Menus Description

NC Program Select and activate part programs. 

Execution Run the active program in the 
Machining or Dry run mode of 
operation. The machine axes are 
moved.

Test Functions for program testing before 
machining. The machine axes are not 
moved.

Settings Settings for the Automatic operating 
mode. 
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The pull-down menus contain the following menu items providing the 
functions or operating modes described below: 

The menu items identified by an asterisk ( * ) are not 
supported by this software version.

NC Program Description

Select Select an NC part program by using 
the file manager.

Autostart * Automatic start of an NC program at a 
programmed time.

Remote After activating remote control, you 
can control all functions from a DNC 
computer. Functions, such as editing 
the tool memory, are deactivated at 
the operating panel of the control.

Ext. program call * Select an NC program by using 
program call numbers that are entered 
in the CNC's memory and activated by 
the PLC.

Last selected programs Quick selection of the four last NC 
programs that were selected.

Execution Description

Machining Machining of NC programs.

Dry run * Test run of an NC program without 
machine movements.

Test Description

Simulation * Graphic testing of NC programs.

Program analysis * Preliminary program analysis in order 
to avoid interruptions in the machining 
process.

Settings Description

NC program * Set the font size.

Execution Program depiction: Show the program 
structure next to the program

Test * Settings for the program test.
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Program selection

If you want to run a program on the machine, you must first select and 
activate the program. To select the desired program, select the

File manager
The file manager manages all programs stored on the drives and in 
the folders. Use the mouse or the ASCII keyboard to select and 
open a program.

Quick selection of the last 4 programs that were selected 
When you select the Select menu item, the last programs that were 
selected are listed at the bottom of the window (including the path). 
You can open a program directly by selecting it from the list.

Program execution

The program you have selected is displayed in the program window. 
When the program activates subprograms during program run, the 
active subprogram is displayed in an additional window to the right of 
the main program. After the subprogram has been finished, the 
additional window is automatically closed.

Program structure

You can also display the program structure in addition to the selected 
program. Some important features of the main program and the 
subprograms, such as tool change, subprogram call, repetitions, etc. 
are listed in the program structure. This gives you a quick overview of 
the program structure, and you can see the program sequence during 
program run. You can also use the program structure for mid-program 
startup.

Select Settings>> Execution to activate the program structure.

Automatic program run (program run, full sequence)

To start the active program, press the START key. In the automatic 
program run mode, the MillPlus executes a part program continuously 
to its end. During program run, the block being executed is highlighted 
by the cursor. If the Program structure window is also displayed, the 
highlight is on the block with the active tool.

Program run, "Single step"

In the program run "Single step" mode, you must start each block 
separately by pressing the START key.
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There are several ways to interrupt program run:

Programmed interruption

Interruption with feed rate STOP key, or feed rate + spindle STOP 
key 

Switching to program run "Single step"

Error message

Programmed interruption

You can program interruptions directly in the part program. The 
MillPlus interrupts the program run at a block containing one of the 
following entries:

Miscellaneous functions M0, M01 or M30 (program end)

Miscellaneous function M06 (determined by the machine tool 
builder)

Interruption with feed rate STOP key, or feed rate + spindle STOP 
key

Feed rate STOP key: The block that is currently being executed by 
the MillPlus is interrupted. The axis movements stop, and the 
spindle keeps rotating.

Feed rate + spindle STOP key: The block that is currently being 
executed by the MillPlus is interrupted. The axis movements stop, 
and the spindle stops.

In either case, the "Program stopped" symbol appears in the tab 
showing the main operating mode. You can resume or cancel program 
run from this position.

Switching to program run "Single step"

You can interrupt a program that is being run in the automatic program 
run mode of operation by switching to the program run "Single step" 
mode. The MillPlus interrupts the machining process at the end of the 
current block. Press the START key to execute the next block.

Breakpoints

You can use breakpoints to interrupt program run without changing 
the program. The program will then be executed up to the breakpoint 
and will not be continued until you restart it. See “Program 
breakpoint” on page 75.

Error message

The machining process may be interrupted, depending on the error 
message class, the machine error or the NC error. The axis 
movements are stopped, and the spindle stops. The "Program error" 
symbol appears in the tab showing the main operating mode, and an 
error message appears in the status bar. 
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You can retract the machine axes during an interruption in the same 
way as in the Manual operating mode.

Intervening program run

It may sometimes be necessary to edit the machining parameters 
during program run. For example, changes can be made in the:

MDI mode of operation

Tool parameter table or workpiece zero point table

Program editor 

In order to edit a program or table, you must first interrupt the program 
run, and then activate the program by pressing the Intervene program 
run soft key.

 Activate intervention.

You also have other possibilities to interrupt the program run:

1 STOP key: Program run is immediately interrupted

 Press the STOP key. (The current block will not be 
executed to its end).

 Activate Single step mode.

 Press the START key to execute the interrupted block 
to its end.

2 Program run "Single step"

 Activate Single step mode. The current block will be 
executed to its end.

Danger of collision

When retracting the axes, ensure that you press the 
correct axis direction keys that match the current 
coordinate system.

The tool should be retracted first, and then the axes 
should be moved away from the workpiece. Please 
keep in mind the workpiece form and the workpiece 
position.

In a tilted working plane (G7), you can use the “Jog in G7 
plane" soft key to switch between the tilted working 
plane and the machine coordinates. 
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You can resume program run after an interruption. The possibilities to 
resume program run vary, depending on the point of interruption.

1 Resuming program run at the point of interruption in the block. For 
this, the block may consist of 

One single instruction, such as a contour section, in the main 
program or subprogram.
A cycle, such as a drilling cycle, in the main program or 
subprogram.

2 Resuming program run at the beginning of the contour section 
block, the macro block or the cycle block. 

This means that some machining operations will be repeated. 
Program run is therefore interrupted, and the Block search 
function is used to find the beginning of the block.

Resuming program run with the START key

 Resume program run soft key: The Distance to go 
window shows the distance from the restart position:

All axes soft key: Move the axes in the sequence 
that the MillPlus suggests. Press the START key.
Restart ? soft keys: Move the axes in any 
sequence. Select the axis/axes by soft key and 
activate them with the START key.

You can resume program run by pressing the START key if the 
program was interrupted in one of the following ways:

The STOP key was pressed.

An interruption was programmed.

If you have moved the machine axes (in the Manual operating mode) 
during the interruption, you can resume program run (in the Automatic 
operating mode) in the following way:

 Press the START key to resume program run.

Danger of collision

Move the axes in the sequence shown in the Distance to 
go window, and not according to the positioning logic.
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Startup point

The mid-program startup function (block search) enables you to run a 
part program from any desired block. The MillPlus scans the program 
blocks up to that point.

 Activate mid-program startup.

There are several ways to select the startup point:

Place the cursor on the desired block in the part program.

Place the cursor on the desired instruction in the program structure, 
which compactly lists the important instructions. If subprograms are 
used, you can open a subprogram using the program structure, and 
then set the startup point in the subprogram.

Use the Find soft key to search for a character string (instruction or 
text) or a line number in the program.

You can also use the Extended search soft key to enter additional 
search criteria, such as the name of the program or subprogram, the 
desired line number or the number of repetitions at the startup 
point.

Mid-program startup (block search)

After selecting the startup point, you can choose between two 
possibilities of getting to the startup point:

 If you press the Go to cursor soft key, the MillPlus 
does not scan the program up to the selected block 
(without calculation). Program run starts directly from 
the selected block.

 If you press the Search to cursor soft key, the 
MillPlus scans the program up to the selected block 
(block search with calculation). After that, program 
run starts from the selected block.

Please note that there is a danger of collision, especially 
when mid-program startup without calculation (Go to 
cursor) is used. The MillPlus therefore displays a warning.

Symbol Description

Caution – Danger of collision: Search program 
without calculation
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You cannot start program run from the selected block until the 
corresponding MSTH functions and the tool position have been 
reached. The MillPlus displays a suggestion in a pop-up window. You 
can accept the suggestion by soft key and execute it by pressing the 
START key. But you can also adapt the suggestion to your 
requirements.

1 MSTH functions: Execute the MSTH functions that have been 
determined through block search with calculation.

In the MSTH function window, select the MSTH functions to be 
executed: 

 Select all MSTH functions (accept the suggestion 
displayed by MillPlus). 

 Remove an MSTH function. All other functions 
suggested by MillPlus are accepted.

 Select one single MSTH function.

 Press the START key to execute the selected MSTH 
functions.

After all selected MSTH functions have been executed, the Distance 
to go window appears. 

2 Distance to go: Move the axes from the current position to the 
startup position. Select the axes:
All axes soft key: Move the axes in the sequence suggested by 
the MillPlus in the window.
Restart ? soft keys: Move the axes in any sequence.

 Press the START key to move the selected axes to the 
startup position.

After all axes have been moved to the startup position, you can start 
program execution. 

Safety notes and general tips

Danger of collision

Move the axes in the sequence shown in the Distance to 
go window, and not according to the positioning logic.

With mid-program startup, program run is continued from 
the selected block. To be able to execute this block, the 
MillPlus may have to execute functions that cause 
collisions. These can be functions, such as tool change 
(approaching the tool change position), rotating the 
(swivel) head and (rotary) table, switching or tilting the 
working plane, approaching the workpiece on a straight 
path and continuing the machining process, etc.
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Optional block skip

In a test run or program run, the MillPlus can skip over blocks that 
begin with a slash (/):

Selectable stop (Selective wait)

The MillPlus optionally interrupts the program run or test run at blocks 
containing M01. 

Before mid-program startup, in the Manual operating 
mode the (rotary) table and the (swivel) head with tool 
must be retracted to a position from which the above-
mentioned functions can be executed without problems 
and without a danger of collision.

It is recommended preparing the machine at the startup 
position in such a way that the program can be 
continued from the startup position without problems.
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Use this function to set breakpoints at program blocks. The program 
will then be executed up to the breakpoint and will not be continued 
until you restart it. You can set multiple breakpoints in succession. 
Breakpoints are not saved in the program.

The breakpoint is identified by a red dot in front of the respective 
block. The red dot is displayed in a column to the left of the program. 
You can clear all breakpoints simultaneously, or you can clear an 
individual breakpoint. For this, you must first activate the program with 
the Intervene program run soft key.

 Define the breakpoint.

There are several ways to find the block in which you want to set a 
breakpoint:

Use the cursor, the PAGE UP/DOWN key or the mouse to navigate 
through the program.

Use the program structure to navigate. 

Use the Find soft key to search for a character string or a line 
number.
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Select and activate part programs. After selection, the MillPlus 
automatically switches to the active mode of operation (Machining, 
Dry run or Test). Default setting: Machining mode of operation.

The NC Program menu contains the following menu items:

Select

"Last selected programs"

Select

Select a part program from the program memory.

Use Select to select an existing part program in the file manager.

Opening the file manager

 Select NC Program in the menu bar.

 Select the Select menu item, select a program in the 
file manager and press ENTER to open it. 

Use the file manager to find the desired program and press ENTER 
to activate it. For navigation, see “File manager” on page 28.

Running a part program

The selected part program is displayed in the program window. 
Depending on the operating mode (Machining, Dry run, Test) that was 
last active, you can start the part program.

 Press the START key to run the part program in full 
sequence or single step mode.

For more information about executing a part program, see “Execution 
Menu” on page 78.
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The menu displays a list of the four last programs that were active in 
the Automatic mode of operation. The name and the path of the 
programs are saved. This enables you to select these programs with 
a few keystrokes.
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Execute the active program in the Machining or Dry run modes of 
operation. The machine axes are moved.

The Execution menu contains the following menu item:

Machining

Machining

Execution of part programs.

You can execute an existing part program in this mode of operation. 
You first have to select and activate the part program in the file 
manager (see “Select” on page 76).

Activating a part program

 Select Execution in the menu bar.

 Select Machining and activate it with the START key.

Starting and interrupting a part program

The selected part program is displayed in the program window. You 
can also activate the program structure by selecting Settings > 
Program structure:

To start program run:

 Press the START key to run the program in full-
sequence mode.

 Press the Single step soft key to run the program in 
single-block mode. You must restart program run 
after every end of block.

 You can interrupt program run at any time. During a 
program interruption you can:

Manually retract the tool from the workpiece and 
return.
Resume program run at the point of interruption or 
from the point of retraction by pressing the START 
key.
Cancel program run with the Cancel program soft 
key. 
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You can activate a status display during program run. The status 
display appears in a window above the machine status display.

Various status displays are available:

Execution status

Offsets

OEM parameters

E parameters

Variables

Press the Full program soft key to deactivate the status display.

Block search (mid-program startup)

Use the Block search function to enter into a part program at a certain 
block and execute the program from this block. See “Mid-program 
startup (block search)” on page 72

 Select Block search to prepare mid-program startup.

 Place the cursor on the block at which you want to 
enter into the program. You can also use the Find 
function to find the startup point.

 Press the Search to cursor soft key if you want the 
MillPlus to scan the blocks up to the startup point 
(block search with calculation). Press the Go to 
cursor soft key if you do not want the MillPlus to scan 
the blocks up to the startup point (without 
calculation).

 Press the START key to activate program run from the 
startup point.
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Settings parameters for the functions provided by the menus and 
menu items in the Automatic operating mode.

The Settings menu contains the following menu item:

Execution

Execution

Select Execution to display the Program structure. The program 
structure lists some important features of the main program and the 
subprograms, such as tool change, subprogram call, repetitions, etc.

You can use the program structure to:

Get a quick overview of the program structure.

Monitor program run.

Find a startup point in the program structure for mid-program 
startup.

 Select Settings in the menu bar.

 Select Execution and press ENTER to activate it. The 
Settings >> Execution window appears.

 Activate the Program structure function.
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The Programming operating mode enables you to create and edit 
programs. New programs can be created immediately via the editor. 
Existing programs must first be found and opened via the file 
manager.

Support for data entry is available when entering data. The level of 
support is automatically adapted to the respective contents of the 
program blocks. Press the Dialog > Function explorer soft key to 
select the G , M or T function groups, and enter the required data into 
the dialog box that appears after selecting a function.

You can also graphically simulate the workpiece to check the 
programmed geometry. The MillPlus offers comprehensive graphical 
functions that provide various views for program run simulation.

Menu bar

In the Programming operating mode you can select a subordinate 
operating mode or a function by using the menu bar or the menu 
items.

Menu bar

Menu items Description

NC program Select a program, or create a new 
program. After selection, the MillPlus 
automatically switches to the active 
mode (editing or graphic simulation).

Window The Window menu lists the programs 
that are open in the program editor. 
The Window menu can contain up to 
seven programs.

Edit Program in the editing mode.

Test Program in the testing mode.

Settings Settings for the Programming 
operating mode. 
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The pull-down menus contain the following menu items providing the 
functions described below: 

The menu items identified by an asterisk ( * ) are not 
supported by this software version.

NC program Description

Open Open an NC part program by using the 
file manager.

New Open the program editor for creating a 
new NC program.

Import from ... * Import programs in .dxf file format.

Last selected programs Quick selection of the four last NC 
programs that were selected.

Window Description

Menu window List of the programs that are open in 
the NC editor.

Edit Description

NC editor Open the NC editor to edit a program. 

Test Description

Simulation The program is graphically simulated 
on the screen.

Settings Description

Edit Define the syntax highlighting, the 
syntax colors and the syntax check.

Test Define the program analysis and the 
graphic simulation.
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Creating/Editing a program

Use the NC editor to create new part programs, or to edit existing 
programs. In the menu bar, select NC program. Then select Open or 
New to call the NC editor.

1 Open: Edit an existing program

Use the file manager to select a file. Use the NC editor to edit the file. 
After editing, you can save or close the program.

2 New: Create a new program

The program editor is started immediately and you can begin entering 
the program. After editing, you can save or close the program. When 
you save the program, the program is saved to a drive under a program 
name via the file manager. For more information, see “NC editor” on 
page 31.

Testing a program

New programs or edited programs can be tested before they are 
executed on the machine. The MillPlus offers various types of tests:

1 Program check: Syntax check of the complete program

To check the program, press the Program check soft key and then the 
Start check soft key. The complete program will be checked. If a 
syntax error is found, the MillPlus displays an error symbol in front of 
the incorrect block (the symbol is displayed in the column to the left of 
the program). All error messages are listed in the Program check 
window. Use the soft keys to navigate through the list or to call 
detailed information on an error message. You can immediately 
correct the incorrect block in the NC editor.

2 Simulation: Graphic simulation of the program in various views

The complete program can be simulated in various views. The graphic 
simulation is displayed next to the NC program. The program can be 
run in automatic mode or in single step mode. Breakpoints can be set 
in order to control the program run.
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Select a program, or create a new program. After selection, the 
MillPlus automatically switches to the active mode (editing or graphic 
simulation).

The NC Program menu contains the following menu items:

Open

New

Last selected programs

Open

Open an NC part program by using the file manager.

Select Open to activate the file manager, in which you select an 
existing program for editing.

Opening the file manager

For navigating in the file manager, see “File manager” on page 28.

 Select NC Program in the menu bar.

 Select Open and press ENTER to open the file 
manager.

Use the file manager to find the desired program and press ENTER 
to activate it.

New

Create a new program with the NC editor.

 Select NC Program in the menu bar.

 Select New and press ENTER.

The New menu item opens a new, blank program in the NC program 
editor. The MillPlus automatically gives the program a name, which 
can be changed when you save the program.

For the editing and support features, see also “Open” on page 85.

Last selected programs

The menu displays a list of the four last programs that were active in 
the Programming mode of operation. The name and the path of the 
programs are saved. This enables you to select these programs with 
a few keystrokes.
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The Window menu lists the programs that are open in the NC editor. 
The Window menu can contain up to seven programs.

The program that is displayed in the editor is identified by a black dot 
in front of the program name. A program that has been edited is 
identified by an asterisk (*) after the program name.
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Edit a program from the list of open programs. After you have selected 
a program, it is automatically opened in the NC program editor.

The Edit menu contains the following menu item:

NC editor

NC editor

If a program is already open, it can be edited with the NC editor. If the 
graphic simulation mode is active, select Edit, NC editor to switch 
to the NC program editor.

Editing a program

An open program can be edited directly.

Various support functions are available for editing a program:

Function explorer for selecting a G or M function. See “Function 
Explorer” on page 27.

Dialog for dialog-based G-function input. See “Input dialogs” on 
page 27.

Online help with more information about programming.

Program check for checking the block syntax.

Syntax highlighting for straightforward program layout.

Adding blocks to the program

If you activate the Add block soft key in the function explorer, the NC 
editor automatically returns to the function explorer every time you 
have entered a new block. By using the dialog function, you can 
quickly create a contour program, for example.

When the Add block soft key is active, the function 
explorer automatically returns to the previous position 
in the program after you have entered a block.

Saving a program

 Press the Save soft key to save a new program or an 
edited program.

Closing a program

 Press the Close soft key to close a program without 
saving. If you have changed the program, the MillPlus 
displays a warning in the status bar: Program 
changed. Save now? You can confirm with Yes or No.
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The Edit functions allow you to change the contents of one or more 
lines in the program. The Cut,  Copy, and Paste functions are 
available. You can also find and replace text in the program, or you can 
search for a line number. For a detailed description, see “Editing 
functions” on page 33.



HEIDENHAIN MillPlus V600 89

4
.5

 E
d

it
 M

e
n

uInteractive programming graphics

While you are writing the part program, you can have the MillPlus 
display a wire plot of the programmed contour. The programming 
graphics is activated by soft key. The graphics shows the program 
section between the Graphics from and the Graphics up to marks.

While you are entering or editing the program lines, the MillPlus 
generates each path contour you program in the graphics window. If 
you do not want the MillPlus to modify graphics during programming, 
deactivate the Redraw graphics after modification function under 
Settings, Edit, Programming graphics.

 Start the programming graphics. 

If you select individual traverse paths in the program with the cursor, 
they will be displayed in orange in the programming graphics. If you 
select a traverse path in the graphics with the mouse, the cursor will 
jump to the associated block in the program.

Select the screen layout (position of program and graphics) in 
Settings, Test, Program list (no program list, or program list at 
bottom, right or left).

Graphic simulation

Use the Graphic functions soft key (or with CTRL +  "+" key) to adjust 
the graphics. You can select the desired view (2-D or 3-D view) or 
adjust the graphics (the graphics can also be adjusted with CTRL + "+" 
key).

Rotate (CTRL + right mouse-pad button)

Magnify/Reduce (CTRL + "+" / CTRL + "–")

Shift (CTRL + left mouse-pad button)

Change the program section displayed in the programming graphics 
by moving the program-end mark:

 From the NC editor, open the soft-key row containing 
the program-end mark (Graphics up to).

 Place the cursor on the desired block in the program 
and press the Graphics up to  soft key. Press the 
Start graphics soft key to display the programming 
graphics up to the program-end mark. 

 Use this soft key to reset the mark to the actual 
program end (default setting).
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The program that is active in the NC editor is checked for syntax errors 
block by block.

Program context: Active / Not active
If Program context is active, modal G functions are taken into 
account in the syntax check. If, for example, G7 is active, the 
MillPlus checks whether the subsequent blocks are allowed when 
G7 is active.

Configuration: Active / Not active
If Configuration is active, the MillPlus checks whether the blocks 
are allowed in the current axis configuration. For example, a block 
with A address is incorrect if the A axis is not configured for the 
machine.

Compatibility: Active / Not active
If Compatibility is active, the MillPlus checks whether the 
execution of the respective program is compatible with the previous 
version V5.xx.

If you want the MillPlus to check the program, you must start the 
program check:

 Press the Start check soft key. If the MillPlus finds 
syntax errors in the program, it displays the number 
of error message in the message line. All error 
messages are listed in the Program check window.

 Use the soft keys to navigate through the error list. 
Detailed information on the error (cause and 
correction) can be called with the Message info soft 
key.

The functions can be activated and deactivated under Settings >> 
Edit.

Online help

You can call additional information about programming and operation 
at any time. See also “INFO functions” on page 37.

 To activate the online help, press the Info key on the 
screen.

The online help is displayed in window that pops up over the displayed 
program. The position and the dimensions of the window can be 
changed using the mouse pointer.

Use the following soft keys to select the desired information:

Programming support 

Operating support

Error support

Calculator
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Functions for program testing.

The Test menu contains the following menu item:

Simulation

Simulation

The graphic simulation depicts the workpiece as if it were being 
machined with a cylindrical tool or a ball-nose cutter. The graphic 
simulation can be run while the program is being executed in the 
Automatic operating mode.

Select Test in the menu bar.

Select Simulation and press ENTER to activate it.

The screen layout for program and graphic simulation varies 
depending on the settings defined in Settings >> Test >> 
Simulation, Program list. See “Settings Menu” on page 95.

Starting/stopping the graphic simulation

Use the Graphics start and Stop soft keys to start/stop the graphic 
simulation. The simulation can be run in single step mode or in 
automatic program run mode.

 Start graphic simulation.

During simulation you can use the Selective wait or /Block skip soft 
keys.

Graphic views and functions

You can choose between different views for the simulation. The 
MillPlus also provides various functions for modifying the view of the 
workpiece.

 Select Graphic functions.

 Select the desired view: Wire plot, 2-D, 2.5-D, 3-D, 
high-resolution 3-D graphics

 Rotate, magnify or reduce the workpiece.

Move the workpiece within the window.

 Detail magnification of a part of the workpiece.
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You can choose between different views for the graphic simulation. 
The MillPlus also provides graphical functions for optimizing the 
screen display. 

If you have activated the corresponding function in Settings >> Test 
>> Simulation, the line numbers are displayed in the simulation, for 
example. See “Settings Menu” on page 95.

3-D wire plot

2-D view

2.5-D view

View Function Description

The tool movements, rapid traverse 
and feed rate are displayed in 
different line colors.

Functions for rotating and 
magnifying/reducing

Functions for moving the image to 
the left/right or up/down

View Function Description

Top view of the workpiece. 
Regarding depth display, remember: 
The deeper the surface, the darker 
the shade.
This is the fastest of the graphic 
display modes.

View Function Description

Top view with two sectional planes, 
similar to a workpiece drawing.
In this view, functions for 
magnifying details are available and 
sectional planes can be set.

Functions for moving the sectional 
plane to the left/right, to the front/
back or up/down

Magnify/Reduce the depiction of the 
workpiece
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High-resolution 3-D view

Views Function Description

The workpiece is displayed in three 
dimensions. You can rotate the 3-D 
display about the vertical and 
horizontal axes.
You can also use the mouse pad to 
execute this function (hold down the 
CTRL key and drag the right mouse 
button).
Functions for magnifying details are 
available in this view.

Functions for rotating and 
magnifying/reducing

Magnify/Reduce the depiction of the 
workpiece

Views Function Description

This view is only possible once the 
simulation has finished. The high-
resolution graphics also displays 
machining operations in the tilted 
working plane.
Functions for magnifying, rotating, 
shifting and magnifying details are 
available in this view.
After the graphics has been 
restarted, the simulation 
automatically returns to the 3-D 
view. The high-resolution view can 
be selected once simulation has 
finished.

Functions for rotating and 
magnifying/reducing

Functions for moving the image to 
the left/right or up/down

Magnify/Reduce the depiction of the 
workpiece
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In the NC program, the workpiece blank must be defined with G99. A 
workpiece blank can only be defined as a quadrangle. G98 and G195 
can also be used to define a workpiece blank.

Table values in the graphic simulation

A copy of the current tables (tools, E parameters, etc.) is used in the 
graphic simulation. The current table values are not changed by the 
simulation.

Program breakpoints

Use the Program breakpoint soft key to set breakpoints at the desired 
positions in the program. The MillPlus stops graphic simulation before 
the breakpoint. To continue the graphic simulation process, press the 
Graphics start soft key. See also “Program breakpoint” on page 75.
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Settings parameter for the functions provided by the menus and menu 
items in the Programming mode of operation.

The Settings menu contains the following menu items:

Edit

Test

Edit

The following functions can be defined in the Edit menu item:

Editor mode: Activate/Deactivate the syntax check and the Editor 
dialog mode.

Syntax highlighting:Activate/deactivate syntax highlighting, and 
use the syntax colors to distinguish between the elements in a 
block. You can choose the colors for the following block elements 
from a palette:
Block ID, comment, character string, keyword, E parameter, 
contour, FMST, G0, G functions, address, invalid address.

Program check: Activate/deactivate inspection of program context 
(including modal functions / only within a block), configuration 
(including axis configuration) and compatibility (including 
compatibility with V5xx).

Programming graphics: Define whether the programming graphics 
is to be executed automatically or after a start command.

Test

The following functions can be defined in the Test menu item:

Simulation: You can define three settings in the Simulation 
window.

Program list: The program list is displayed next to the graphic 
simulation (None, Right, Bottom or Left)
Display contour in wire plot view: Active / Not active
Line number in wire plot: Active / Not active
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All data for tools, datums, etc., as well as data regarding the machine 
configuration is managed in the Control (Setup) operating mode. The 
other operating modes use this data.

The NC-Explorer is a file manager with which you can handle your files 
and directories.

There are management functions with which you can control your 
production tasks for purposes of automation.

Functions for diagnosing and optimizing the control and machine are 
available during commissioning as well as during operation of the 
MillPlus.

Menu bar

In the Control (Setup) operating mode you can select a subordinate 
operating mode or a function via the menu bar or the menu items.

Menu bar

Menu items Description

Tables The values for tools, E parameters and points 
are saved in tables.
The tools are listed in groups of applications

NC-Explorer Use the NC-Explorer to manage your files and 
directories

Automation Management of automation tasks and pallets

Installation Machine and system configuration data, as well 
as support functions for commissioning and 
maintenance

Settings Settings specific to the Control operating mode
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The pull-down menus contain the following menu items providing the 
functions described below: 

The menu items identified by an asterisk (*) are not 
supported by this software version.

Tables Description

Tools Tool data of all tools, divided into 
groups

Tool magazine Tools and their pocket numbers in the 
magazine

Zero points Tool- and pallet-specific datums

Parameter Overview of E and ES parameters

Points Predefined points

NC-Explorer Description

File Management of files and directories

Automation Description

Tool management * Illustration of the tool magazine

Installation Description

Diagnosis Diagnostics functions of the control

Compensation Configuration and axis compensation

Configuration System configuration with machine-
configuration data

System backup * Data backup during installation

Service Support functions, such as 
oscilloscope, axis values (OLM), 
PLC values, SIK, MOD, network, error 
display

Settings Description

Tables Setting for the tool-dialog mode



100 5 Control (Setup) Operating Mode

5
.2

 M
e

n
u

: 
T
a

b
le

s 5.2 Menu: Tables

The Tables menu is used to view and edit the various tables for tools, 
parameters and points. The menu window shows an overview of the 
available tables. If there is an arrow after the table name, then further 
selection is possible.

The Tables menu contains the following items:

Tools

Tool magazine

Zero offsets

Parameter

Points

Navigation is identical in all the tables. You must press the Edit soft 
key if you want to edit the table. Press the Find soft key to search for 
a value or text in the table.

Tools

The tool table contains a definition of each tool, as well as its data. 
Each tool is identified by a number. When working with tool tables, 
you can also enter tool names for each tool.

The tool number 0 is automatically defined as the zero tool with the 
length L=0 and the radius R=0. In tool tables, tool T0 should also be 
defined with L=0 and R=0.

See the Technology chapter of the Programming Manual for a 
complete overview of the tool-parameter definitions.

Opening and editing a tool table

The Tools table can be divided into the various tool types, based on 
the application groups. All tools are shown in the All group. In the 
other groups, only those tools assigned to the selected application 
group are shown.

Here are the tool application groups:

Cutter

Drill

Tap

Cutting tool

Measuring probe
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switch between the tool application groups and the 
tool table.

 Opens the table for editing. The data is entered via the 
ASCII keyboard. Press the ENTER key to 
automatically save the changes to the table and move 
to the next cell.

Tool editing with support for data entry

You can use the support for data entry when editing a table. The data-
entry support is opened with the Dialog soft key. The support window 
closes automatically if the Entry ready or Return keys are pressed. If 
you want this support to be provided at all times, then activate the 
Tool dialog mode under the Settings > Tables menu item.

 Opens the dialog input window

 The entered data is saved in the table. The focus 
returns to the edited tool in the table.

 Data entry is cancelled without saving the data. The 
focus returns to the edited tool in the table.

Adding or deleting a tool

Once you have set the table to editing mode, you can use the soft 
keys to add a tool to the table, or delete the tool.

 Adding a tool: A window opens, in which you enter the 
tool group and tool number. You can then enter the 
tool data in the tool dialog window.

 Deleting a tool: The tool selected in the table is 
deleted.
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Name Inputs

P Magazine and pocket identification: The magazine number is before the decimal point (optional), and 
the pocket number after the decimal point

T_NR Tool number (8.2): Number by which the tool is called in the program. The code for the associated 
replacement tool is after the decimal point

IDX Index number, programmed T2= value in the NC program (maximum: 9)

NAME Name of the tool (max. 40 characters)

L Tool length L

R Tool radius R

R2 Tool radius R2 for toroid cutters (only for 3-D radius compensation or graphical representation of a 
machining operation with corner rounding cutters)

DL Oversize tool length L

DR Oversize tool radius R

DR2 Oversize tool radius R2

O Tool orientation, orientation for corner radius for turning tools

TL Set tool lock (0=not locked, 1=locked)

TS Tool status 
0 = Not defined
1 = Measured and OK
2 = Out of tolerance
3 = Broken
4 = Tooltime expired

TIME1 Maximum tool life in minutes. This function can vary depending on the individual machine tool. Your 
machine manual provides more information on TIME1.

TIME2 Maximum tool life in minutes during an M6: If the current tool age exceeds this value, the MillPlus 
changes the tool during the next M6 call of the replacement tool (see also CUR.TIME) Required tool 
life in NC language programmed in T3=

CUR.TIME Current tool age of the tool in minutes: The MillPlus automatically keeps track of the current tool age. 
A starting value can be entered for used tools.

TYPE Tool type for defining the tool shape:
UNDEFINED = not defined
MILL = milling cutter
DRILL = drilling tool
TAP = tapping tool
TURN = turning tool
TCHP = touch probe

DOC Comment on tool (max. 40 characters)

PTYP Tool type for evaluation in the tool magazine table (this address must be entered if Tin-Tout is used)
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PLC Information on this tool that is to be sent to the PLC

LCUTS Tooth length of the tool

ANGLE Maximum plunge angle of the tool for reciprocating plunge-cut in cycles. If this value is 90, then it is 
assumed that the cutter can plunge into the material vertically.

NMAX Limits the spindle speed for this tool. The programmed value is monitored (error message) as well as 
an increase in the shaft speed via the potentiometer.

LIFTOFF Definition of whether the MillPlus should retract the tool in the direction of the positive tool axis at an 
NC stop in order to avoid leaving dwell marks on the contour.

P1, P2, P3 Machine-dependent function: Transfer of a value to the PLC. Refer to your machine manual.

T-ANGLE Point angle of the tool. Is used by the Centering cycle in order to calculate the centering depth from 
the diameter entry (currently without function).

PITCH Thread pitch of the tool (currently without function)

Name Inputs
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Name Inputs

CUT Number of teeth (20 teeth maximum)

LTOL Wear tolerance of the tool length L. If the entered value is exceeded, the MillPlus locks the tool (status 
L). Input range: 0 to 0.9999 mm

RTOL Wear tolerance of the tool radius R. If the entered value is exceeded, the MillPlus locks the tool (status 
L). Input range: 0 to 0.9999 mm

DIRECT. Cutting direction of the tool for measuring the tool during rotation (-1=M3, +1=M4). 
If this value is not entered, M3 is assumed.

R_OFFS For tool length measurement: Tool offset between stylus center and tool center. 
Preset value: tool radius R

L_OFFS Tool radius measurement: Additional tool offset between upper surface of stylus and lower surface of 
tool. Default: 0

LBREAK Permissible deviation from tool length L for breakage detection. If the entered value is exceeded, the 
MillPlus locks the tool (status L). Input range: 0 to 0.9999 mm

RBREAK Permissible deviation from tool radius R for breakage detection. If the entered value is exceeded, the 
MillPlus locks the tool (status L). Input range: 0 to 0.9999 mm
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Name Inputs

PROBE Touch probe type

CAL_OF1 During calibration, the MillPlus stores in this column the center misalignment in the reference axis of 
the 3-D probe, if a tool number is indicated in the calibration menu.

CAL_OF2 During calibration, the MillPlus stores in this column the center misalignment in the minor axis of the 
3-D probe, if a tool number is indicated in the calibration menu.

CAL_ANG. During calibration, the MillPlus stores in this column the spindle angle at which the 3-D probe was 
calibrated, if a tool number is indicated in the calibration menu.

RAPID_FEED Rapid traverse for probing

PROBE_FEED Measuring feed rate

MEAS_RANGE Maximum measuring range

SAFETY_DIST Safety clearance

ALLOW_FF Pre-positioning at rapid traverse

POS_PROBE Oriented spindle stop
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A replacement tool is inserted when the tool life of the current 
machining tool expires, or, if monitoring of the tool-cutting force is 
active, when the lowest permissible level of performance cannot be 
attained.

The replacement tool is identified by the last two digits of the tool 
number. This means that up to 99 replacement tools can be assigned 
to a tool.

Tool oversize (DL, DR, DR2)

These parameters serve to define the oversizes of the tool shape. The 
actual length of the tool is the length (L) plus the length oversize 
(DL). The actual radius of the tool is the radius (R) plus the radius 
oversize (DR). The length and radius compensation functions use 
these length and radius values. If nothing is entered, the value zero is 
assumed. The actual corner radius of the tool is the radius (R2) plus 
the corner radius oversize (DR2).

Monitoring of tool age (TIME1, TIME2, CUR.TIME)

TIME1 indicates whether the tool age of a specified tool is to be 
monitored.

TIME1= assigns a tool life in minutes to the tool. The range for the tool 
life is 1 to 9999 minutes.

Whenever a tool is in use, its CUR.TIME in the memory is increased 
by the cutting time. 

Once the tool life has expired, a warning is output and the tool is 
locked with TL=1.

If the same tool is called again, a replacement tool is inserted, if there 
is one.

Tool length L + DL
Tool radius R + DR
Corner radius R2 + DR2

The length is used for length compensation, the radius for 
radius compensation (G41-G44 or G141), and the corner 
radius for 3-D radius compensation (G141).

TIME1=0 Tool age not monitored.
TIME1= >0 Specification of tool age, which is monitored.
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The tool places are defined in the Tool magazine table, and the 
corresponding tool numbers are indicated. A complete overview of the 
tool parameters is given in the section on the tool table.

For a tool magazine, a tool table stating the places in the magazine for 
each tool as well as the other relevant data must be created before the 
first program is run.

In the event of a tool change (M6), the programmed tool is extracted 
from the magazine.

Tool magazine parameters

The machine tool builder adapts the functional range of the 
magazine table to the requirements of your machine. 
Refer to your machine manual.

Name Inputs

P Identification of the magazine and place. Magazine number before the decimal point (optional), place 
number after the decimal point

T Identification in the tool table without index after the decimal point 

PNAME Description of the place name (max. 40 characters)

RSV Reserved pocket. Place is reserved, e.g. for the tool in the spindle

ST Special tool, places directly before and after this place are locked in column L

F Fixed pocket. The tool is always returned to this place

L Place locked. Display: Yellow

PLC Information on this tool that is to be sent to the PLC

P1, P2, P3, P4, P5 Value 1 to 5. Machine-dependent function: Transfer of a value to the PLC. Refer to your machine 
manual.

PTYP Tool type for evaluation in the place table, same as PTYP of the tool

LOCKED_ABOVE Locks the place above. For magazine rules

LOCKED_BELOW Locks the place below. For magazine rules

LOCKED_LEFT Locks the place at left. For magazine rules

LOCKED_RIGHT Locks the place at right. For magazine rules
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The ST word indicates whether the tool only occupies one place in the 
tool magazine, or if it is an oversize tool occupying three places, i.e. the 
place in which the tool is located as well as the two empty places to 
the left and right of the tool, for example. Such a tool must be returned 
to the same place in the magazine after use.

Datums

The Zero offsets table has definitions of datums, such as those that 
you have defined with the Manual >> Workpiece >> Touch side 
function.

There are datums for:

Workpieces

Pallets

Parameters

The values for E parameters and ES parameters are saved in the 
Parameter table.

There are parameter tables for:

E parameters

ES parameters

Points

The axis coordinates are specified in the Points table under the point 
numbers.
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The NC-Explorer gives you an overview of the available files and the 
structure of the directories.

The NC-Explorer menu contains the following item:

File

File

Use this function to manage files and directories via the file manager. 
This includes functions like cutting, copying and pasting files, 
renaming files and directories, and adding new directories.

Functions

When the NC-Explorer is open, a soft-key row with the following 
functions is shown: 

Soft keys Description

File functions (copying, cutting, pasting, searching)

Change the name of a file or directory

Create a new directory

Split the screen into one or two file-manager 
windows

Go up one level in the directory structure

Write-protect a file. The attribute (r) is set for the file.
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Use the Installation functions to view and edit the MillPlus 
configuration data.

The Installation menu contains the following items:

Diagnosis

Compensation

Configuration

Service

Compensation

Configuration

Use the Compensation >> Configuration function to specify the axis 
assignments via the configuration table.

Axes

Use the Compensation >> Axes function to view and edit the various 
axis-compensation tables.

Configuration

System

Use the Configuration >> System function to view and edit various 
types of configuration data (machine parameters).

User soft keys

Use the Configuration >> User soft keys function to assign names 
and images to user soft keys. The table also indicates whether a script 
is available for the respective soft keys (see “User Soft Keys” on page 
39).

Please note that only trained personnel may change the 
configuration or diagnose the MillPlus.

The functions listed below are described in detail in the 
Technical Manual.

We strongly recommend contacting your machine tool 
builder before you change these settings on the MillPlus.
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The Service function is intended particularly for commissioning and 
troubleshooting of the MillPlus by specialists. Numerous basic 
settings for the MillPlus can be entered, as well as changes made. 
This function is also well-suited to diagnosing and optimizing the 
MillPlus for the machine tool.

Oscilloscope

The control features an integrated oscilloscope. This oscilloscope 
features six channels for recording analog signals and 16 channels for 
recording digital signals.

Axes (OLM)

The OLM (online monitor) supports the commissioning and diagnosis 
of control components by displaying variables for axes and channels, 
as well as by displaying hardware signals.

Various trace functions can be used and commands activated.

PLC

The integrated PLC of the control contains its own text editor for 
creating the PLC program. This service function provides the Service 
department with more information about the PLC.

SIK

On the standard version of the MillPlus, four control loops (3 axes + 
1 spindle) are enabled. Further control loops can be enabled by the 
machine tool manufacturer. You can enable further control options by 
entering a code number.

If you wish to enable additional software options, please contact your 
machine tool manufacturer for the code number. You will be given the 
code number after stating your SIK number.
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Most machine-configuration data is specified by the machine tool 
manufacturer. You can change some configuration data, i.e. the user 
parameters, yourself. Enter the code number 123 in the MOD mode.

User parameters available for you to change:

DisplaySetting

ProgrammingSettings

CfgUserPath

CfgSystemTime

CfgEditorSettings

NCchannel

Network

If the MillPlus is connected to a network, it also displays the 
connected network drives in the directory window. All functions 
(selecting a drive, copying files, etc.) also apply to network drives, 
provided that you have been granted the corresponding rights.

The USB interface of the control

Backing up data from or loading onto the MillPlus is especially easy 
with USB devices. The MillPlus supports the following USB block 
devices:

Floppy disk drives with FAT/VFAT file system

Memory sticks with the FAT/VFAT file system

Hard disks with the FAT/VFAT file system

CD-ROM drives with the Joliet (ISO 9660) file system

The MillPlus automatically detects these types of USB devices when 
connected. The MillPlus does not support USB devices with other file 
systems (such as NTFS).

The USB devices appear as separate drives in the file manager, so you 
can use the file-management functions correspondingly.

Please ensure that the correct procedure is maintained 
when removing a USB device.
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The MillPlus generates error messages when it detects problems such 
as:

Incorrect data was entered during programming

Logical errors arise in the program during program testing or 
program run

System errors during operation

If an error occurs, a symbol appears in the main operating mode tab, 
and an error message appears in the message line. Select the Service 
>> Error view menu item to open a window with additional 
information about this error. See also “Error support” on page 38.
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Settings parameters for the menu functions in the Control (Setup) 
operating mode.

The Settings menu contains the following item:

Tables

Tables

You can set the tool dialog mode under the Tables menu item.



Miscellaneous



116 6 Miscellaneous

6
.1

 A
c
c
e

s
s
o

ri
e

s 6.1 Accessories

3-D touch probes

With the various HEIDENHAIN 3-D touch probe systems you can:

Automatically align workpieces

Quickly and precisely set datums

Measure the workpiece during program run

The TS 640 triggering touch probe

This touch probe is particularly effective for automatic workpiece 
alignment, datum setting and workpiece measurement.

The TS 640 touch probe features infrared transmission of the 
triggering signal to the control. This makes it highly convenient for use 
on machines with automatic tool changers.

Principle of operation: HEIDENHAIN triggering touch probes feature a 
wear-resistant optical switch that generates an electrical signal as 
soon as the stylus is deflected. This signal is transmitted to the TNC, 
which stores the current position of the stylus as an actual value.

HR electronic handwheels

Electronic handwheels facilitate moving the axis slides precisely by 
hand. A wide range of traverses per handwheel revolution is available. 
Along with the HR 130 and HR 150 panel-mounted handwheels, 
HEIDENHAIN also offers the HR 410 portable handwheel.
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3-D touch probes ... 116

A
Application window ... 26
ASCII keyboard ... 29
Automatic mode of operation > 

Execution ... 78
>Machining ... 78

Automatic mode of operation > NC 
Program ... 76

>Last selected programs ... 77
>Select ... 76

Automatic mode of operation > 
Settings ... 80

> Execution ... 80
Automatic operating mode ... 66
Axes (OLM) ... 111
Axis configuration ... 41
Axis-direction keys

Tilted plane ... 49

B
Block search (mid-program 

startup) ... 72

C
Calculator ... 37, 38
Compatibility ... 19
Compensation ... 110
Configuration ... 110
Context menu ... 34
Continuous jog ... 48
Control (Setup) operating mode ... 98
Control > Installation ... 110
Control > NC-Explorer ... 109

>File ... 109
Control > Settings ... 114

>Tables ... 114
Control > Tables ... 100

>Parameters ... 108
>Points ... 108
>Tool magazine ... 107
>Tools ... 100
>Zero offsets ... 108

Coordinate system ... 41
Coordinates ... 41

D
Data, finding ... 30
Datums ... 42

E
Editing functions ... 33
Error display ... 113
Error messages ... 113
Error support ... 38

F
Feed rate STOP ... 69
File manager ... 28
FSTM entry ... 50
Function Explorer ... 27

G
G7 coordinates ... 41
General status display ... 35
Graphics ... 91

2.5-D ... 92
3-D ... 93
3-D, high-resolution ... 93
Plan view ... 92
Wire plot ... 92

H
HR handwheel ... 116

I
Incremental jog ... 49
INFO functions ... 37
Input dialogs ... 27
Instructions ... 19
Interruption ... 70
Interruption of program run ... 69, 71

J
Jogging ... 48

L
Line number and status symbol ... 31

M
Machine operating panel ... 21
Main operating modes ... 22
Manual axes, positioning ... ... 51
Manual operating mode ... 44
Manual operating mode > Machine 

tool ... 62
> NC shutdown ... 62
> Reference point ... 62

Manual operating mode > MDI ... 61
> Free entry ... 61

Manual operating mode > 
Settings ... 63

> Jogging ... 63
Manual operating mode > Tool ... 59

> FST entry ... 59
> Measure in jog ... 60
> Set plane ... 60

Manual operating mode > 
Workpiece ... 56

> Determine center ... 57
> Preset axes ... 58
> Touch side ... 56

MDI
Free entry ... 52

MDI.pm ... 52
Menu bar ... 23

Automatic operating mode ... 66
Control (Setup) Operating 

Mode ... 98
Manual operating mode ... 44
Programming operating mode ... 82

Menu items
Automatic operating mode ... 67
Manual operating mode ... 45

Message line ... 25
Mid-program startup ... 72
Mid-program startup with Go to 

cursor ... 72
Mid-program startup with Search to 

cursor ... 72
MillPlus IT with Windows ... 18
MOD ... 112
Moving the machine axes ... 48
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Names of files and directories ... 29
NC editor ... 31, 32
Network ... 112
New functions ... 6

O
Online help ... 37
Operating concept ... 22
Operating functions ... 27
Operating support ... 37
Optional block skip ... 74
Oscilloscope ... 111
Override knobs ... 50

P
PLC ... 111
Popup windows ... 34
Program breakpoint ... 75
Program check ... 90
Program execution ... 68
Program run "Single step" ... 69
Program run correction ... 70
Program selection ... 68
Program structure ... 68, 80
Program, closing ... ... 87
Program, creating/editing ... ... 84
Program, editing ... ... 87
Program, saving ... ... 87
Program, testing ... ... 84
Programming > Editing ... 87

> NC editor ... 87
> Test ... 91

Programming > NC Program ... 85
> Last selected programs ... 85
> New ... 85
> Open ... 85

Programming > Settings ... 95
> Edit ... 95
> Test ... 95

Programming > Window ... 86
Programming operating mode ... 82
Programming station ... 19
Programming support ... 37

R
Reference point ... 42, 47
Reference point, crossing over ... ... 47
Reference system ... 41
Resuming program run ... 71

S
Safety ... 20
Screen and NC keys ... 21
Screen layout ... 28
Selectable stop (Selective wait) ... 74
Sequence of operations ... 29
Service ... 111
Shortcuts

CTRL+... ... 34
SIK ... 111
Soft-key row

Machine functions ... 26
NC functions ... 26

Spindle STOP ... 69
Startup point ... 72
Status display ... 23, 35
Status displays ... 36
Support for data entry ... 28
Switch-off ... 48
Switch-on ... 46
Symbols ... 22
Syntax checking ... 31
Syntax highlighting ... 31
System bar ... 25

T
Table editor ... 30
Table settings ... 30
Table, editing ... 30
Tool measurement ... 55
Tool, editing ... 101
Traversing with the HR 410 

handwheel ... 49

U
USB ... 112

V
Visual display unit and operating 

panel ... 21

W
Workshop oriented ... 18

Z
Zero point, setting... ... 54
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